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Disclaimers and Legal Information 
Copyright © 2015 Aimetis Inc. All rights reserved. 

This material is for informational purposes only. AIMETIS MAKES NO WARRANTIES, EXPRESS, IMPLIED OR STATUTORY, AS TO 
THE INFORMATION IN THIS DOCUMENT. 

Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no 
part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any 
means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written 
permission of Aimetis Corp. 

Aimetis may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject 
matter in this document. Except as expressly provided in any written license agreement from Aimetis, the furnishing of this 
document does not give you any license to these patents, trademarks, copyrights, or other intellectual property. 

Aimetis and Aimetis Symphony are either registered trademarks or trademarks of Aimetis Corp. in the United States and/or 
other countries. 
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Document History 

Date Description 

January 5, 2015 Release 6.13.2.4 

December 12, 2014 Release 6.13.2.3 not generally released 

December 3, 2014 Release 6.13.2.2 not generally released 

November 19, 2014 Release 6.13.2.1 not generally released 

November 13, 2014 Release 6.13.2 

October 1, 2014 Release 6.13.1.4 

September 3, 2014 Release 6.13.1.3 

August 27, 2014 Release 6.13.1.2 

August 20, 2014 Release 6.13.1.1 

August 1, 2014 Release 6.13.1 

June 25, 2014 Release 6.13.0.3 

June 19, 2014 Release 6.13.0.2 

June 13, 2014 Release 6.13.0.1 

May 27, 2014 Release 6.13 
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Release 6.13.2.4 

Fixed 

Fixed 
AIR-24288 Symphony Client no longer displaying  erroneous popup message to delete 

camera from farm 

 

Release 6.13.2.3 not generally released 

Fixed 

Fixed 
AIR-24288 Symphony Client no longer displaying  erroneous popup message to delete 

camera from farm 

 

Release 6.13.2.2 not generally released 

Fixed 

Fixed 
AIR-24237 Axis P7016 encoder tracker CPU usage decreased 

AIR-24238 Multiple ADAM devices on one server working correctly on failover 

 

Release 6.13.2.1 not generally released 

Fixed 

Fixed 
AIR-24077 Heatmap report contains correct and complete data for recorded days 
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Release 6.13.2 

Includes previously privately released 6.13.1.x patch updates as of August through October 
2014. 

Improved 

Improved 
AIR-1944 Digital zoom available for videos played in Symphony Player 

AIR-7687 Analytics: New video record mode added: Schedule and Pixel Changes Detected 
by PC that records whenever pixel changes are detected as objects are tracked 
through the scene, but only during the time period specified. 
Note: The Symphony license determines which Analytics options are available. 

AIR-17463 Analytics: Display warning on video "Dropping frames due to insufficient 
processing resources. Try reducing analytics resource needs" for supported 
cameras when frames are not processed quickly enough or frames are dropped 

AIR-21863 On Client Settings > Maps tab, you can now define whether rule icons are always 
visible with a specific colour and transparency level using the Always show rule 
icon, Default color, and Transparency options. 

 
When configured, all rule icons on maps share the same color (and any 
configured transparency value) when not in an alarm.  When an alarm occurs, the 
rule icons can be different colours, as defined on the Alarms tab. 

AIR-21864 When a camera is set to Switch view when an alarm occurs, you can now lock 
and unlock the current video using a keystroke in addition to right-clicking and 
selecting Enable Automatic Switching.  
 
Press and hold SHIFT and click the video panel to temporarily pause and prevent 
camera switching. Repeat it to resume camera switching. 
(ShowEventSwitchingLock=True must be set in the acc.ini file)  
See: http://www.aimetis.com/Support/kbarticle.aspx?ID=10326 

AIR-22284 Improved alarm generation 

AIR-22911 Help now available online and in Symphony installation 

http://www.aimetis.com/Support/kbarticle.aspx?ID=10326
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Improved 
AIR-23417 SDK changes – See SDK documentation 

AIR-23437 PTZ location displayed on Live and Historical views 

AIR-23543 VE180 Outdoor default interface parameters updated 

AIR-23553 SDK: User can stop video via new None Camera option 

AIR-23568 AXIS Edge Storage: download process from SD card restarted automatically after 
interruption 

AIR-23847 Erroneous switching to port 1756 in direct connection to Bosch camera corrected 

AIR-23947 Export Video now has option to include Symphony Player when exporting aira 
files 

Fixed 

Fixed 
AIR-11141 Emailing picture as linking working correctly 

AIR-11266 Correct image saved/displayed when selecting Send Picture To in multiview 

AIR-12008 Full image saved when Send Picture To selected in live/recorded video 

AIR-16928 Help > Report an Issue includes all server logs 

AIR-17463 For high CPU usage with PT091 and VE180, warning message displayed: 
“Dropping frames due to insufficient processing resources”  

AIR-17894 RTSP URL video format setting saved and applied correctly 

AIR-20240 Videowall: Working correctly when loading new device model 

AIR-20879 Farm reporting correct version after backup restored 

AIR-20921 Alarm log alarm rule names no longer displaying as blank  

AIR-22302 Server > Video Wall option no longer causing the Client to hang 

AIR-22551 Johnson Controls P2000 Access Control working correctly -  multiple rules can be 
tied to the same events and the same alarm camera 

AIR-22769 Multiviews working correctly with two or more PTZ cameras using joystick control 

AIR-22839 LPR functioning correctly in Windows 7, Chinese edition 

AIR-22857 Re-starting Symphony services via the Client re-enables and restarts all tracker 
services, even trackers currently disabled.  
 
The following setting configured via the Manual Configuration Editor ensures that 
trackers remain disabled when services are restarted: 
Type: Global 
Section: Main 
ID: <empty string> 
Key: EnableTrackersBeforeStart 
Value: <either “true” or “false”> - set to “false” to ensure that disabled trackers 
remain disabled after a service restart 

AIR-22882 LPR working correctly. “License plate recognition hardware lock error” avoided 

AIR-22936 Video rendering improvements implemented 

AIR-22967 Frame rate variances causing unsynchronized playback resolved 
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Fixed 
AIR-23034 Web Client timeline displays the PTZ Auto tracking timeline (pink line) indicators 

correctly 

AIR-23038 Server > Services > Manage Symphony Services > AI Infoservice > Toggle no 
longer producing erroneous error 

AIR-23074 Decoration “camera tour enabled” visible when Camera Tour enabled (Right-click 
on live video > Camera Tour > Enable) 

AIR-23119 After connecting to the Gallagher access control device initially, checkbox options 
can be selected 

AIR-23121 Privacy masks working correctly for edge storage historical video 

AIR-23124 Connecting to Access Device with incorrect credentials displays appropriate error 

AIR-23125 Clicking Ignore when you see a “Server is not connected” message now adds that 
server to an acknowledged list, and users now only see unacknowledged server 
messages display 

AIR-23154 SDK: Alarm Time displaying server’s local time instead of Coordinated Universal 
Time (UTC) 

AIR-23155 SDK: Privacy masks working correctly 
Note: Privacy mask is not applied in direct mode 

AIR-23156 Privacy Masks working correctly with rules, video searches, and when managing 
analytics configuration 

AIR-23176 Chinese characters correctly displayed in playback video 

AIR-23177 The URL to access the Web Client with username, password, and a live video of a 
specific camera ID using URL variables has been changed to: 
http://[SERVERNAME]:50000/login.aspx?U=jsmith&P=FIY1TQ %3D&C=7&R=1 
See the KB article https://www.aimetis.com/Support/kbarticle.aspx?ID=10311 for 
further details. 

AIR-23192 Decoration color settings propagated throughout all servers in the server farm 
correctly 

AIR-23193 Server Configuration dialog Server field displays the hostname of the server 
where the device is connected 

AIR-23194 SDK: Panel switching working correctly 

AIR-23195 Device List correctly populated following server upgrade 

AIR-23196 Disabled PTZ notifications include usernames which are visible only to users with 
administrative privileges 

AIR-23197 Phoenix: Input mapping corrections implemented to prevent missing and 
duplicate input triggers 

AIR-23198 Video decoration font improvements implemented 

AIR-23199 Licensing working correctly in large multi-server farms where servers have 
multiple MAC addresses and network interface controllers 

AIR-23200 When a connection is lost, or a camera moves to a different server, client 
reconnects to historical video stream correctly 

AIR-23201 Camera tree updating immediately following device model changes. 
New devices added show with ID of 0 until the server updates with the correct 

https://www.aimetis.com/Support/kbarticle.aspx?ID=10311
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Fixed 
camera ID 

AIR-23202 Videowall: Mixed mode working correctly where server version is different than 
client version 

AIR-23203 Videowall: In a multi-server farm environment, concurrent panel switch 
commands working correctly 

AIR-23204 Creating a New Camera View from an existing camera group working correctly 

AIR-23205 Device Tree Configuration Cancel option working correctly 

AIR-23206 Device model changes applied correctly when the Server Configuration dialog is 
open 

AIR-23207 When importing a PTZ camera as a fixed camera, editing the camera’s device 
configuration overwrites the camera type correctly 

AIR-23208 Maps: Client connection status visible in Maps panel 

AIR-23210 Web Client: Server connection performance and logging enhancements 
implemented 

AIR-23211 Video recording stops correctly when an alarm is triggered for a camera set to 
never record with a post-event buffer; recording stops when the entire post-
event buffer is complete 

AIR-23228 Creating and managing map links no longer result in duplicate data 

AIR-23234 VE150 and VE180 showing images in the correct aspect ratio 

AIR-23241 Timeline: Purple circle displays the correct time 

AIR-23243 Restricted users can view live video when the database is unavailable 

AIR-23244 Moving digital I/O devices to another server signalled correctly via SNMP 

AIR-23245 
AIR-23250 

Timeline: Purple circle indicating the current video panel position displaying 
correctly 

AIR-23246 Speed improvements implemented when switching live video via direct 
connection 

AIR-23247 You can now hide the mouse cursor on live video displaying on any video panel. 
When this feature is enabled, the mouse cursor disappears after five (5) seconds 
of mouse inactivity. The cursor reappears immediately when the mouse moves or 
when an alarm popup appears in the system tray. 
 
This feature is disabled by default. To enable the feature per server, edit 
%appdata%\<ProductFolder>\acc.ini  and change the following parameter as 
needed: 
[CameraVideoView]  
CursorOffOnVideo=True 
 
Note: When an Alarm popup appears in the system tray, the cursor disappears 
five (5) seconds later until another alarm is detected. 

AIR-23249 Setup Wizard working correctly in silent mode 

AIR-23251 Viewing blank camera working correctly 

AIR-23253 Symphony Manager services working correctly for users with Administration 



 

 
Copyright © 2015 Aimetis Corp.  9 

Fixed 
privileges 

AIR-23254 Web Client: Banning and unbanning video no longer causes camera tree display 
issues 

AIR-23255 Changing video decoration transparency working correctly 

AIR-23256 Users Viewing Camera option refreshing correctly when logged in user changed 

AIR-23257 Help > Report an Issue > Upload to Aimetis option saves file to desktop correctly 

AIR-23258 Video export working correctly 

AIR-23259 Device Tree configuration Apply option no longer resulting in Client crash 

AIR-23260 Web Client: Server popup messages display and refresh correctly showing a 
maximum of 3 messages at any time 

AIR-23261 Videowall: No longer logging erroneous “Failed to connect to videowall 
controller” error during load balancing 

AIR-23262 Web Client: Timeline hidden after banning device 

AIR-23264 Switch view when an alarm occurs functionality working correctly without 
logging erroneous exceptions 

AIR-23265 Videowall: Decoration transparency settings pushed correctly to all viewers 

AIR-23266 Videowall Manager: No longer logging error when changing video quality 

AIR-23267 Videowall: Performance improvements implemented 

AIR-23268 Server Configuration > General Settings > Decoration Text Background color 
preview displays the color name for Black and White and specific RGB values for 
any other specified color 
Note: Color preview does not include any configured Transparency value 

AIR-23269 When attempting to switch panels using the SDK to unregistered clients, a 
notification error is displayed 

AIR-23271 Videowall: Clicking Refresh in Videowall Manager working correctly 

AIR-23252 
AIR-23263 
AIR-23270 
AIR-23272 
AIR-23273 

Videowall: No longer logging erroneous errors when switching panels 

AIR-23274 Videowall: Blue panel errors no longer displaying and File > Send Picture working 
correctly 

AIR-23275 Digital I/O rules import and export via CSV loading policies and rules correctly 

AIR-23276 View Current Logins functionality (Server > View Logins > Current Logins) displays 
computer hostnames only and not IP addresses 

AIR-23277 Client lock Panel add/Panel close functionality working correctly 
View > Settings > Lock > Panel adding/closing hides related menu buttons and 
their associated View menu options 

AIR-23278 Modifications to Messenger message text size and position are correctly applied 
and updated 

AIR-23295 Vivotek: Live & historical audio sound working correctly 

AIR-23304 VE180: Outdoor Mode > Advanced Configuration > New Object Min Travel 
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Fixed 
(Meters) Distance default set to 1.0 m 

AIR-23325 Client no longer locked for up to 30 seconds when exporting video from server 
with older software version   

AIR-23327 View > Settings > Maps > Always show maps icon option & color selection 
defines rule color correctly when a rule is dragged onto a map and when rule is 
triggered. Support also added for custom colors. 

AIR-23328 SDK: Able to get historical JPEG for the selected time or a current JPEG through 
LiveStreamTest as desired. In the Alarms section can now request to fetch new 
alarms on demand. 

AIR-23351 Automatic backup upload failures no longer resulting in the storage of multiple, 
unnecessary backup files 

AIR-23352 Server > Backup working correctly locally and online 

AIR-23356 Following a Symphony upgrade, accessing historical video captured prior to the 
upgrade working correctly 

AIR-23358 Opening Server > User Configuration no longer hanging intermittently 

AIR-23359 Client interface unlock functionality no longer displaying erroneous permission 
error 

AIR-23360 
AIR-23363 

Client interface refresh and video playback performance improvements for 
deployments with many devices 

AIR-23362 Manually overriding camera record mode working correctly 

AIR-23364 Touching a hidden mouse cursor no longer results in an erroneous error message 
when playing historical video 

AIR-23365 Device I/O triggering alarms correctly during database outage 

AIR-23366 
AIR-23639 

Multiple cameras video export working correctly 

AIR-23390 Setup wizard working correctly in silent mode 

AIR-23398 Cameras successfully moved during server merge 

AIR-23399 Adding a second video stream when Symphony storage (Server > Configuration > 
Storage) is configured to use Max Days working correctly 

AIR-23406 New Report > Heat Map Report > Next Page> Camera Selection> Heat Map 
view> Select Different Image option results in error message “Failed to get image 
from camera” when camera is disconnected 

AIR-23417 Interface improvements implemented, including the ability to: 

 Subscribe to live events over a TCP stream 

 Retrieve historical events via Mobile Bridge Server 

 Subscribe to specific Symphony events including rules and license plate 
detections 

An SDK sample demonstrates how to get historical alarm & LPR events from 
Mobile Bridge, as well as subscribe to and unsubscribe from live events. 

AIR-23423 Chinese: “Connection Failed” message translated  

AIR-23429 SDK: Clicking Mark Alarm in a Live Stream Test with no alarm selected no longer 
displays erroneous error message 
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Fixed 
AIR-23431 SDK: During a Live Stream Test, clicking on any option no longer switches the 

current camera to another camera 

AIR-23432 SDK: SSL support added to Mobile Bridge SDK sample application 

AIR-23441 Server > Configuration > Swap Servers working correctly 

AIR-23442 Switching to a docked quad view working correctly 

AIR-23443 VE140/VE141: Choose Image button removed since these algorithms are not 
configurable 

AIR-23471 SDK: Adding alarms to camera and inserting alarms working correctly 

AIR-23473 Rules: Importing cameras via CSV file for an alarm event rule working correctly 

AIR-23508 Changing the analysis resolution on one tour location for a PTZ camera tour no 
longer displays erroneous on-screen error message when the camera moves to 
that location 

AIR-23523 Camera Setup for RTSP video streams added to the Device Tree working correctly 

AIR-23529 Changing between different multiple camera views working correctly 

AIR-23532 SDK: Mobile Bridge returns a current JPG regardless of whether or not the tracker 
is configured to record 

AIR-23533 Corrected issue where the permission system became partially corrupt if multiple 
users adjusted the same permission at the same time 

AIR-23546 When resizing the video area, video playback continues to play correctly 

AIR-23554 SDK: Mobile Bridge live video displayed only once camera is selected 

AIR-23555 Video export working correctly 

AIR-23558 SDK: Mobile Bridge camera list working correctly after disconnecting and 
reconnecting to a server farm 

AIR-23580 Setup Wizard completion no longer erroneously runs Windows Program 
Compatibility Assistant 

AIR-23593 When de-warping historical video, the Send Picture to option dewarps the video 
image correctly 

AIR-23594 Switching cameras in the Device Tree to configure a camera that is off is working 
correctly 

AIR-23596 SDK: Export Video sample includes a Disconnect button to change the farm for 
video export 

AIR-23597 SDK: Mobile Bridge camera option None blanks camera view 

AIR-23599 Modifying locations and camera tours and closing camera views working correctly 

AIR-23640 SDK: Mobile Bridge camera additions and deletions working correctly  

AIR-23647 Direct connect video displays proper date and time 

AIR-23651 SDK: Export video sample working correctly 

AIR-23705 Changing algorithms when the PT091 analytic and dual video streams are enabled 
is working correctly 

AIR-23707 Users are notified when event log data is unavailable via Server > View Logins 
and Help > View Detailed Events due to the Event Log being disabled (Server > 
Configuration > General Settings > Event Log > Enable Event Log) 
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Fixed 
AIR-23722 Lost Camera Connection alarms are received and camera connections are not re-

established in the event that the database becomes temporarily unavailable 

AIR-23848 Chinese: STMP server label size adjusted to fit text 

AIR-23859 Restoring configuration from backup on multi-server farm working successfully 

AIR-23921 Log cleaning issue corrected to rectify issue of multiple trackers found in stopped 
state and unsuccessful fail-over 

AIR-23950 Daily scheduled alarm report working correctly on multi-server farm. 
Important: Reports are run only on master servers.   

 

Release 6.13.1.4 

(Not generally released) 

Fixed 

Fixed 
AIR-23584 SDK: Farm Test sample includes a new Loop Video option and a Video Length 

(seconds) control. When Loop Video is enabled, switching the panel to the 
historical video loops the video for the length of time specified. 

AIR-23587 Camera tour location name decoration available for live and historical video 
See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10320 for details 

 

Release 6.13.1.3 

(Not generally released) 

Fixed 

Fixed 
AIR-23412 WebClient: Timeline is hidden immediately after banning a device 

AIR-23413 WebClient: Reloading URL to show specific camera correctly displays live video 

 

  

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10320
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Release 6.13.1.2 

Fixed 

Fixed 
AIR-23388 Following a Symphony upgrade, able to access historical video captured prior to 

the upgrade 

 

Release 6.13.1.1 

Fixed 

Fixed 
AIR-23393 Client no longer locked for up to 30 seconds when exporting video from server 

with older software version   
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Release 6.13.1 

Includes previously privately released 6.13.0.1, 6.13.0.2, and 6.13.0.3 patch updates. 

New 

New 
VIS-86 VE180 Outdoor Multi-Class Object Tracking implemented and features the 

following improvements: 

 increased robustness to environmental conditions 

 better suppression of shadows 

 updated object overlap penalty to prevent tracking boxes within masked 
out regions 

 reduction of CPU usage 

 
AIR-19295 Automatic calibration support added for perspective cameras (overhead or 

angled view) 
 

AIR-20624 Automatic calibration added to VE180 analytics configuration for supported 
devices.  
 
Automatic calibration determines the optimal camera configuration for scenes 
containing people. You can switch to manual calibration at any time, and the 
system retains the last best estimation of camera position detected. 
 
Auto Calibration option available in Server Configuration > Devices > Analytics 
Configuration > Overview > Camera Position 
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New 

 
AIR-22945 Clear alarms configures how Symphony Client clears alarms in the alarm log every 

24 hours at midnight.  
 
On each server, edit %appdata%\<ProductFolder>\acc.ini  and change the 
following parameter as needed: 
[Main] 
ClearAlarms = All 
 
Values include:  

 All (default) – all alarm logs are cleared 

 None – alarm logs are not cleared 

 Marked – only alarm logs marked as acknowledged 

 Viewed – only alarm logs marked as viewed are cleared 
 
Note: Alarms generated less than 24 hours in the past are never deleted 
regardless of how the Client is configured. 
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Improved 

Improved 
AIR-20083 Support added for Windows 8.1 Enterprise Edition, 64-bit Operating System 

AIR-22334 Arecont: Auto Discovery support added via Server Configuration > Discover 
Devices feature 

AIR-22846 VE180 indoor tracking shadow suppression improvements implemented 

AIR-22749 Privacy mask improvements implemented: 

 % Surrounding Object – the percentage of the area the privacy blur is applied 
to beyond the tracking box. Applies only to dynamic privacy masks.   

 Mask Delay (seconds) – the number of seconds to remember the position of 
tracked objects and continue blurring their previous position.  Applies only to 
dynamic privacy masks.   

 Blur Amount – the amount of blur applied to the area. Applies to both static 
and dynamic privacy masks. 

 
AIR-22901 VE180 Indoor People Tracking analytic configured for Overhead camera position 

by default 

AIR-22993 
AIR-23083 

Client Notification bar correctly indicates which individual servers in a multiple 
server farm are down 

AIR-22944 PTZ camera response time improvements implemented 

AIR-23026 In Server Configuration > Storage, enabling the Limit the number of days video is 
stored option visibly disables the Default max storage days option in the 
interface 

AIR-23031 New alarms implemented: 

 If the connection with the video system has been lost because the server is 
disabled or shuts down or the network connection is lost 

 When the video server has reconnected and is operational and/or the 
network connection is re-established 

 If the list of cameras (and PTZ presets) changes and the video server may 
need to update its cache (such as when camera is added, deleted, or 
renamed, or if a PTZ camera's presets are added, deleted, or renamed) 
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Improved 
AIR-23041 PT091: Calculates object speed based on tracked foreground points, when 

available. If there are tracked key points in the region that don't correspond to 
background motion, the PT091 analytic uses that motion data to estimate the 
motion of the foreground object. 

 

Fixed 

Fixed 
AIR-18360 No longer displaying erroneous message after generating bug report log package 

AIR-18762 IQeye: Live video and historical video playback working correctly 

AIR-19038 Camera storage path modifications persist correctly and discarded changes are 
not saved 

AIR-20895 Gallagher Access Control alarm popups working correctly 

AIR-21424 When connected to more than one server, interface responsive after switching 
cameras 

AIR-21736 Device decorations, including camera name and ID, display in the center of the 
live screen view 

AIR-22036 Siemens SPC device alarms being received successfully 

AIR-22276 Axiom RBH access control rule action correctly forcing associated cameras to 
record 

AIR-22374 WebClient installations no longer displaying erroneous CAB errors 

AIR-22426 Visible objects that do not overlap masked-in portions of the area by 10% or 
more are no longer being tracked 

AIR-22433 You are prompted to select a tracking algorithm when enabling the VE101 
analytic for a device 

AIR-22436 Exporting thumbnails via Alarm Log working correctly 

AIR-22441 Multiple login deny user permission working correctly 

AIR-22456 Privacy masks are applied for rule and analytic configuration as well as video 
search results for users without the appropriate permission 

AIR-22687 Map link placement improvements implemented 

AIR-22689 Client responsiveness improvements implemented during device model refresh 

AIR-22690 Static privacy mask control setting retained correctly 

AIR-22692 Device connections including adding and removing cameras working correctly 
following  a server IP address change 

AIR-22723 Server/Client connectivity improvements implemented 

AIR-22745 LPR: No longer generating bitmap of every image that generates an exception. 
Error images now written to the standard date-and-camera directory within the 
_images directory in the data folder. 

AIR-22758 Historical video playback working correctly 

AIR-22777 When playing historical video, purple circle indicates the correct Timeline position  
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Fixed 
AIR-22778 Email on alarm functionality now correctly including attachments 

AIR-22811 When the camera is set to not record, and there is no historical video available 
when the user attempts to select an image for algorithm configuration, the 
system attempts to get an image from tracker instead of displaying a “no footage 
found” message 

AIR-22827 Alarm popups working correctly across multi-server farms 

AIR-22831 When a device is set to record on motion detected by PC but no analytics engine 
is selected, you are prompted to select a different recording mode for the device 

AIR-22834 Privacy masks working correctly using the mobile client 

AIR-22837 PTZ control panel functions working correctly 

AIR-22847 Fisheye Dewarping: PTZ buttons working correctly in wall mount mode 

AIR-22855 PTZ autotracking timeline indicator improvements implemented when the device 
is not configured to raise an alarm 

AIR-22858 HTTP authentication added for auxiliary PTZ commands 

AIR-22882 LPR: Multiple cameras simultaneously running LPR no longer displaying the error 
“License Plate Recognition – Hardware lock error” on the live view panels 

AIR-22887 Client is no longer erroneously applying Privacy Masks when the server is older 
than 6.13 

AIR-22888 Analytics configuration is no longer freezing on load. Analytics configuration is no 
longer available initially when a device is added.  
 
You must successfully add a device, close the Server Configuration dialog, and 
reopen the dialog to access the Analytics Configuration tab options. 

AIR-22890 Video export email notification working correctly 

AIR-22905 Line counting conversion working correctly without errors for non-English 
Operating System installations 

AIR-22919 Video decoration font improvements implemented 

AIR-23002 Phoenix hardware device inputs and outputs being detected correctly 

AIR-23040 Server Configuration > Devices List > Server field supports server hostnames and 
IP addresses 

AIR-23057 Alarm Log: Video panel working correctly in Advanced Mode when an alarm is 
selected 

AIR-23071 
AIR-23016 

Report distribution via email working correctly 

AIR-23101 When creating a rule for the VE180 analytic, all three (3) classes of objects are 
selected by default, including: People, Vehicles, and Unknown 

AIR-23122 Client now logs when the requested analysis FPS (frames per second) value is 
greater than the capture FPS 
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Release 6.13.0.3 
(Not generally released) 

Fixed 

Fixed 
AIR-22884 Mobile Bridge requests for JPEG images no longer resulting in occasional 

decompression errors 

Release 6.13.0.2 
(Not generally released) 

Fixed 

Fixed 
AIR-22779 Vivotek: Edge storage video downloads working correctly following connectivity 

interruptions 

AIR-22862 Axis: LPR detection and privacy mask stability improvements implemented for 
edge storage footage downloads 

AIR-22897 Active Directory integration working correctly when upgrading while Setup 
Wizard is in offline mode 

AIR-22900 Accessing the Web Client and a live camera video working correctly 
Note: Encoded Passwords that include equal signs (=) must be escaped as %3D. 
See AIR-21421 for parameter details. 

 
Release 6.13.0.1 
(Not generally released) 

Fixed 

Fixed 
AIR-22779 Vivotek: Edge storage video downloads working correctly following connectivity 

interruptions 

AIR-22819 Vivotek: Automatic playback stream switching working correctly 
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Release 6.13 
Includes previously privately released 6.12.4.x patch updates as of May 26, 2014. 

New 

New 
AIR-20889 Dynamic and Static Privacy Masks 

 
In Symphony analytics configuration, you can define dynamic and static privacy 
blur masks per device for cases where privacy is a concern. Privacy masks can be 
configured for all motion tracking video analytics in Symphony. 
 
When privacy masks are defined, operators can validate alarms but cannot 
identify people in live or historical video.  
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New 
Configure Privacy Masks 
1. In the Symphony Client, within the Server Configuration dialog  

(Server > Configuration), select a device whose analytic you want to configure 
with a privacy mask. 

2. Select the Analytics Configuration tab. 
3. Select Privacy Mask from the Analytics Engines drop-down list. 

 
 
Define a Static Privacy Mask 
Static privacy masks blur the area of a drawn region for static areas such as 
entrance ways. 
1. Enable the Static Privacy Mask checkbox. 
2. Using the displayed image from the video, define the area in gray (the privacy 

mask) where objects in that defined area should be blurred. 

 Select the Erase option to erase the grey privacy mask. 

 Select the Draw option to draw the grey privacy mask.  

 The Size slider adjusts the pen thickness. 
3. Click OK to save your changes. 

 
 
Define a Dynamic Privacy Mask 
Dynamic privacy masks dynamically blur motion tracking boxes for moving 
objects such as people walking. 
1. Enable the Dynamic Privacy Mask checkbox. 
2. Click OK to save your changes. 
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New 

 
 
Privacy masks are transmitted with decorations in live and historical video 
streams with every key frame (or every eighth frame for MJPG). They are also 
saved to disk. 
 
Note: Privacy masks are permission-driven. Users denied the View Private Video 
permission will always see the privacy mask applied. System administrators 
granted the permission will never see applied privacy masks. 

AIR-21421 Access the Web Client with username, password, and a live video of a specific 
camera ID using URL variables as follows: 
 
http://[SERVERNAME]:50000/Default.aspx?U=jsmith&P=FIY1TQ==&C=7&R=1 
 
where: 

 [SERVERNAME] is the Microsoft® Windows® Hostname or the IP address 
of the Aimetis Symphony Server 

 U= is the User Name 

 P= is the Encoded Password (Generate the encoded password using the 
Aimetis Password Encode Utility located in C:\Aimetis Symphony Install 
folder\_tools\PasswordEncoder.exe) 

 
 C= is the Camera ID to load 

 R= prevents the server from load balancing the request by redirecting the 
request to another server. Not intended for production deployments. 

Note: Ensure that each variable is separated by the ampersand symbol (&). 
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New 
AIR-22263 Auxiliary command support added for applicable PTZ cameras and video server 

devices 
See https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10293 

 

Improved 

Improved 
AIR-18765 LPR – Can set how long to keep a license plate visible after a car has left the scene 

in seconds using a new Plate Display Time field 

AIR-20786 South American LPR module support improved 

AIR-21158 PTZ Lock Timeout is ignored for PTZ calibration 

AIR-21369 Export Video right-click option added to the Timeline and available when a Start 
Time and End Time is marked. 

AIR-21415 Arab LPR module support improved 

AIR-21459 Rule status correctly toggled via ADAM module 

AIR-21539 Refactored PTZ movement control logic and camera command systems for 
improved stability and performance 

AIR-21544 SDK WebServiceConsole GUID argument support added 

AIR-21738 SNMP calculates footage size when redundant storage used 

AIR-21778 InfoService logs now include the location of %APPDATA% for system processes 

AIR-21831 LPR plate size on-screen draw options added and Analysis Heuristical Sensitivity 
option removed 

AIR-21874 Retrieving edge storage JPEG and historical video for multi-channel AXIS video 
encoders working correctly 

AIR-21935 Mexico LPR module support improved 

AIR-21936 Latin LPR module support improved 

AIR-21937 Taiwan LPR module support improved 

AIR-21938 USA/Canada LPR module support improved 

AIR-22005 PT091: Zooming can be suppressed during auto tracking 

AIR-22011 Moroccan LPR module support improved 

AIR-22187 PT091 improvements implemented to support PTZ autotracking performance 
with thermal cameras 

AIR-22190, 
AIR-22197 

The Auto track object and Follow object to other cameras auto-tracking 
commands have been removed from the live video feed right-click menu 

AIR-22245 Embedded CHM help link replaced with centralized webhelp link 

AIR-22324 LPR: Opacity of the plate rectangles set to 75% to ensure plate characters are 
visible 

AIR-22333 VE180 shadow suppression improvements implemented 

AIR-22406 LPR: Default minimum and maximum value adjustments applied for the first 
instance of Slant and Slope 

AIR-22675 Microsoft® Windows Server®  2012 R2 support added 

https://www.aimetis.com/Xnet/KB/KBArticleView.aspx?ID=10293
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Fixed 

Fixed 
AIR-15738 Camera audio plays via second stream correctly for live video, exports, and 

historical video playback 

AIR-19058 ALPR working successfully in cases where motion detection chaining is disabled 

AIR-19186 PTZ panoramic mask generation working correctly 

AIR-20748 Occasional LPR crashes resolved 

AIR-20861 Alarm emails no longer missing attachments on systems configured for a non-
North American date/time format 

AIR-21007 Client no longer logging application errors during videowall panel switching 

AIR-21108 Users can access historical data successfully 

AIR-21122 Images are cleaned at the correct time 

AIR-21155 Rule actions working correctly with Access Control devices in Symphony 

AIR-21157 Unlicensed systems display an error message when importing cameras using a 
CSV file: Camera {0} could not be added. Please ensure all servers are up and 
adequately licensed. 

AIR-21233 AXIS cameras recovering successfully following disconnections 

AIR-21234 Adding a second server to a server farm updates licenses correctly 

AIR-21307 Switch view on alarm working correctly 

AIR-21308 Web Client: Displaying Profile Switch messages correctly 

AIR-21309 The View Blank Camera option working correctly when viewing JPEGs 

AIR-21312 Symphony no longer exhibiting issues when camera setup does not match the 
actual camera configuration 

AIR-21313 SDK VideoWallClient sample supports video wall hostnames and IP addresses 

AIR-21330 Advantech Adam-6060 digital IO: Erroneous message no longer displays when 
trying to disconnect 

AIR-21342 VE180 Outdoor Mode no longer erroneously showing unknown objects when 
unknown object detection is disabled; classification checkbox options for the 
outdoors interface have also been removed 

AIR-21394 When supported cameras are configured for Corridor Mode, changing the frame 
rate for the camera correctly adjusts on reconnect 

AIR-21414 Adding a server to an existing server farm working correctly 

AIR-21422, 
AIR-21456 

PTZ camera unlock and home commands are working correctly 

AIR-21473 Discover Devices ONVIF discovery working correctly 

AIR-21530 Footage maintained correctly to prevent recording gaps 

AIR-21617 Multiple email addresses separated by commas are working correctly in the 
Advanced Search panel 

AIR-21636 Following storage restoration, correct time values recorded 

AIR-21640 Axiom RBH Access Control working correctly 

AIR-21646 If an unavailable storage path is detected, the system does not try to write to the 
unavailable disk 
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Fixed 
AIR-21719 Import Cameras Template XLS file > Valid Entries tab headers are formatted 

consistently 

AIR-21744 PTZ Calibration camera right-click option hidden for non-Enterprise licenses 

AIR-21812 Server merge successful when source farm contains more than eight (8) maps 

AIR-21822 Alarm times correct and in sync with alarm images 

AIR-21861 Switch User correctly updating stored credentials when the Client is configured to 
prompt users for credentials at startup 

AIR-21876 Redundant storage works better in configurations with slower media 

AIR-21897 Live video camera panel views working correctly 

AIR-21900 License Configuration verification step no longer failing in Setup Wizard due to 
Xnet connection timeout 

AIR-21962 Large scale solution improvements implemented 

AIR-22007 PT091: Alarm no longer erroneously detected throughout FLIR PTZ camera 
autotracking 

AIR-22024 PTZ lock decoration no longer erroneously showing “ptz locked [] P[0]” when the 
camera is not locked 

AIR-22026 Switching PTZ locations no longer results in an alarm click jumping to an incorrect 
point in the timeline 

AIR-22088 VE180 Restore Default working correctly 

AIR-22100 Johnson Controls P2000: Alarms working correctly in a multiple server farm 
environment 

AIR-22185 Searching for alarms working correctly 

AIR-22192 Erroneous empty Show Details button no longer available following a Client error  

AIR-22194 Clear alarms at midnight working correctly 

AIR-22199 CoreVision configuration parser correctly supports multiple masks by validating 
mask name during mask load 

AIR-22204 Video export End Time accuracy improved 

AIR-22216 Resizing a window with dewarped JPEG resizes correctly  

AIR-22217 Removing PTZ home locations working correctly when the VE180 analytics engine 
enabled 

AIR-22226 Server able to access historical video from a network drive 

AIR-22234 Servers no longer erroneously removed from the Server List as already registered 

AIR-22237 Current Timeline position (purple circle) no longer moving erroneously following 
JPEG retrieval from edge storage 

AIR-22239 VE130 search for alarms only no longer results in "No footage Found " error 

AIR-22242 Unlicensed Axis camera application error no longer being erroneously logged 

AIR-22359 Axis: Device discovery working correctly via ONVIF 

AIR-22360 Setup Wizard delay increase to prevent slow internet connections to Xnet 
timeouts 

AIR-22370 Remote system backups working correctly when the server farm is on a separate 
network from the client 
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Fixed 
AIR-22461 Axis fisheye camera floating multi-view switches from fisheye to dewarp view 

correctly 

AIR-22548 Web Client: Erroneous “Graph is not connected” message no longer displays after 
clicking Live View button 

AIR-22549 Alarms inserted through SDK correctly displayed on Symphony Web Client Alarm 
Log  

AIR-22552 Manual Configuration Editor interface OK button enabled when a cell value is 
updated 

AIR-22557 VE180: When creating a new rule, interface refresh issues resolved when clicking 
Refresh Image button on the Event tab 

 


